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QUICK TUTORIAL

SMARTMOTOR NUMERIC CONTROL™

QUICK TUTORIAL

SmartMotor Numeric Control™, (SMNC™), is a G-Code based Servo Motion 
Control system developed by Animatics Corporation that delivers multi-axis 
contouring without an expensive control panel and without a cabinet full of con-
trols.  SMNC™ is built on Animatics’ SmartMotor™ technology that compresses 
a Controller, Amplifier and Encoder into a long life Brushless Servo Motor.  A 
power supply, three motors, a cable and a PC complete the system.  You can 
write G-Code programs or import them from AutoCad® DXF files, and check, 
analyze, and run them.  You can also use SMNC™ to write SmartMotor™ Coor-
dinated Motion files and run them.  In a Coordinated Motion file the position 
coordinates and time values are organized in a table.  Executing the G-Code 
program or Coordinated Motion File results in smooth and continuous, multi-
axis contouring.
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INSTALLATION

When in a windows environment, insert the SMNC™ installation CD in your 
CD-Driver and follow the instructions during the installation process.  If you are 
installing from floppy disks, insert the first disk and run the setup.exe program 
contained on the disk. 

At the end of the installation, an icon will be added to your desktop and a group 
named SmartMotor Numeric Control will be added to the start menu.

INSTALLATION

Figure 1:  SMNC™ installation program.
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RUNNING SMNC™

Double-click the SMNC™ icon on your desktop to run it.  Figure 2 shows the 
main window of SMNC™:

RUNNING  SMNC™

Figure 2: Main window components of SMNC™.

The SMNC™ 
screen is designed 
to emulate the 
appearance of a 
typical CNC 
terminal.
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CONNECTING THE MOTORS

Before you can use this program with motors, you must make the connections 
for power and serial communications. You may have from 1 to 6 motors, con-
nected to your computer. The motors can be connected to the computer using 
an RS-232 Daisy Chain, an RS-232 Star, or an RS-485 Bus cable.  Figure 3 
shows some different communication configurations for motors. 

CONNECTING THE MOTORS

Figure 3:  Different Communication configurations:

a) RS-232 Star configuration
b) RS-232 Daisy Chain configuration
c) A combination of RS-232 Star/Daisy Chain configuration
d) RS-485 Bus configuration
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Different 
SmartMotor 
versions are 
available with a 
variety of different 
connector 
arrangements.  
The “D” type 
connectors are 
recommended for 
new designs.

CONNECTING THE MOTORS

Figure 4:  Typical RS-232 
Daisy Chain. 

Figure 5:  Motor Connector Pin 
Identifications.
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CONNECTING THE MOTORS

Figure 6:  Motor Connector Arrangements. 
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Figure 7:  24V I/O Interfacing Techniques.
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COMMUNICATION SETUP

On the menu bar, select the Setup sub-item from the Tools menu.  The Setup 
property sheet will appear.  Select the Channels page from the list at the left 
side of property sheet. (Figure 8)

COMMUNICATION SETUP

By default there are always two 

channels defined on this page. You 

can define more channels depending 

on your communication configuration.  

Click on the Add button to define 

another channel. The Add new Chan-

nel dialog box will appear. (Figure 9)

Enter the channel name, serial port 

and bit rate and leave other fields with 

their default settings.  Click on the OK 

button and you will see the new chan-

nel is added to the list in the Channels 

page of Setup property sheet.

Figure 8:  Channels page of Setup property sheet.

Figure 9:  Add new Channel dialog 
box
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Now select the Axes page in the page list at the left to show the Axes page of 
Setup property sheet. (Figure 10)

Select the number of motors in the Number of Axes combo box.  In this example 
we select 3 motors to setup the configuration shown in part (c) of figure 3.  
Therefore we will have 3 Axes, namely X-axis, Y-axis, and Z-Axis.  Assuming all 
of the motors are connected to one port on the computer, do the following:

In the X-tab, enter 1 for Motor Address, and select Channel1 for the Used Chan-
nel. 

In the Y-tab, enter 2 for Motor Address, and select Channel1 for Used Channel. 

And in the Z-tab, enter 3 for Motor Address and select Channel1 for Used Chan-
nel. 

Leave other fields unchanged with their default settings. Click on the OK button 
of the property sheet.

Connect the motors as you configured and setup in previous sections and turn 
on the power.  Click on the Connect button on the Panel View or select the Con-
nect sub-item from the Tools menu.  The program opens the serial port/s and 
both addresses and initializes the motors.  After a few seconds, the current posi-
tion of the device will be shown in the Panel View.  The Connect button’s face 
will change to Release and the jog buttons will be enabled.

COMMUNICATION SETUP

Figure 10:  Axes page of Setup property sheet.

It may be 
necessary to 
further “tune” your 
SmartMotors if the 
motion is sloppy 
or unstable.  To 
tune the motors 
press the Tuning 
Button.  Generally 
speaking, if the 
motors buzz you 
need to lower KP.  
If the motors 
appear too soft or 
compliant, you 
need to raise KP.  
Raise KD to 
dampen the motion 
and lower KD if 
the motors make a 
grinding sound.
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Use these buttons to manually navigate 
along the axes.  When you press a 
button, it moves along its Axis using the 
speed, acceleration, and step specified 
in the Panel Page of the Setup property 
sheet and this Jogging Page.  You can 
use these Jogging buttons in different 
ways. (Figure 11)

1. Click on any of these buttons to move 
along the axis in a positive or neg-
ative direction.  Each time you click 
on the button, the motor will move 
one step using the current increment 
value selected in the Increment group 
box.   You can define the increment 
values in the Panel page of the Setup 
property sheet.

2. Click and hold the left mouse button 
on any of these buttons.  The axis 
moves continually until you release 
the button.  This movement uses the 
speed and acceleration defined in the Panel page of the Setup property sheet 
and Jogging Speed Scroll bar.

3. If your mouse is equipped with a wheel, you can middle-click on any of jog 
buttons and enter the wheel mode for that axis.   In this mode you can use the 
wheel of mouse to move along the selected axis.  To exit the wheel mode you 
should middle-click again on the same jog button.  You can use the previous 
two methods for other axes while in wheel mode for the selected axis.  If you 
middle-click on another jog button, an axis currently in wheel-mode will exit 
wheel mode, and the new selected axis will enter wheel mode.

Servo button: 

When the indicator on the Servo button is Green, the motors are servoing (hold-
ing in position).  Try to move the motors manually (but only if it is safe to do 
so: NEVER PUT YOUR HANDS ANY PLACE WHERE A SERVO RUNAWAY 
COULD CAUSE YOU HARM).  You will see that you cannot move the device 
easily.  Now press the Servo button to turn it off.  The indicator will change 
color to Black indicating the off state of motors.  If it is safe to do so, now try to 
move the motors manually.  You will see that the device moves easily.  When 
the motors are in the Servo state, they apply torque when needed to maintain 
their current position; so you cannot move them by hand.  The Servo state auto-
matically becomes on, when you change the current position using the Jogging 

JOGGING

Jogging Buttons: 

JOGGING

Figure 11:  The Jogging page on the 
Panel View.
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JOGGING

buttons.  Servo state is also on (and the servo button disabled), while running 
G-Code and Coordinated Motion Files.  You can change the servo state for each 
individual SmartMotor™ using the Button/Indicator near the position value of 
each axis.

Goto Button:

Click on the Goto button on the Panel 
View.  The Go to new position dialog 
box will appear. (Figure 12)

Enter a value of 1 for all axes and 
click on the Ok button.  You will see 
that the device moves to point (1,1,1) 
and the current position boxes show 
the movement and freeze when the 
device reaches the destination point.

Click again on the Goto button and 
click the Send X-Y Home button.  You 
will see that the device moves to the 
point (0,0,1).  Try the Send Home and 
Send Z Home buttons in the Go to 
new position dialog box and see the 
results.

Set Home button:

Use the Goto or jog buttons to move to the coordinate (0.1,0.1,0.1).  Now click 
on the Set Home button.  The Coordinate Transformation dialog box will appear. 
(Figure 13)

In this dialog box, you can set current position to home without movement.  You 
can also use the advanced form of this dialog box and set current position for 
each axis to a value. Select the OK button.  You will see the current position 
shown on the Panel View will change to (0,0,0), indicating that from now on, the 
current position is the home.

Figure 12: The Go to new position 
dialog box

Figure 13: Coordinate Transformation dialog box
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JOGGING

Increment Values:

You can change the increment for single-click jogging and wheel-mode jogging 
using these radio buttons.  These four options are defined in the Panel page of 
the Setup property sheet.

Jogging Speed Scroll bar:

The Initial Jogging speed and acceleration are defined in the Panel page of the 
Setup property sheet, however you can change the jogging speed directly from 
Panel View using this scroll bar.  The jogging speed value, as set by the scroll 
bar, is shown in a box below the scroll bar.
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WRITING AND RUNNING A G-CODE PROGRAM

Click on the Source View to get the keyboard focus.  Now type the following 
G-Code program in the Source View (exactly how G-Codes work will be 
described in the next section):

G1X0Y.5Z0
G2I.5J0
G1Z.5
G2I.5J0
G0Z0
X0Y0

From the File menu, select the Save As sub-item and in the Save As dialog 
box, type a name for the G-Code program and save it.  Now press the Start 
button on the Panel View, or select the Run sub-item from the G-Code menu.  
SMNC™ checks the program and then starts running.  The device will go to the 
point (0,0.5,0) and draw a circle. Then it will go up to the point (0,0.5,0.5), draw 
another circle, return to the zero position and stop.  Try running this program a 
few times.  Note that when you start running a program, the Setup and Connect/
Release buttons change into Pause and Stop buttons respectively. (Figure 14)

Now click the Step button.  You 
will see that the device moves and 
stops.  Click the Step button again.  
It will run a line and stop at the 
beginning of next G-Code state-
ment on the next line.  You can 
continue in Step mode using the 
Step button repeatedly or you may 
cancel Step mode by clicking the 
Start button.

Click on the Start button to run 
the program again and click the 
Pause button while it is running.  
You will see that the motors decelerate to a stop.  You can cancel the pause 
mode and continue running the rest of program from this point by clicking again 
on the Pause button or simply clicking the Start button.

Click the Start button again to run the program.  Try the Stop and Emergency 
Stop buttons when the program is being run.  When you use the Emergency 
Stop the motors stop at once and the Servo turns off.  The Stop button does 
the same, but the servo remains on.  Note that this is the default setting for the 
Emergency stop and Stop buttons.  You may change the default setting using 
the General page of the Setup property sheet.

You can use the Feedrate scroll bar on the Panel View to change the speed 
during the movement, Pause mode or Step mode.  Please note that when you 
track the button of scroll bar, the new speed, shown in the box below the scroll 

WRITING AND RUNNING A G-CODE PROGRAM

Figure 14: Running Buttons before and 
during running.
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bar, will become effective only when 
you release the button.

Run the program and this time take 
a look at the Run time Parameters 
group box in the Run Time Page 
on the Panel View. (Figure 15). 
When you start a program, SMNC™ 
changes the page automatically so 
that you can see the Run Time 
Parameters. The speed is increased 
at the start of each segment and 
approaches the value selected by 
the Feedrate scroll bar.  It then 
decreases to zero at the end of seg-
ments in an amount proportional to 
the sharpness of the angle.  If the 
motion segments are tangent, there 
is no slowing.

The Elapsed Time shows the time 
in seconds and increases as time 
passes.  The Current Units show 
that the values in the G-Code pro-
gram on the current line are in Inch.  
The Current Mode shows that the current coordination mode at the running 
G-Code line is Absolute. The Current Origin shows that the current logical origin 
at the running G-Code statement is home.

The progress bar at the bottom of this group box shows the portion of the current 
G-Code line done relative to its total length.

WRITING AND RUNNING A G-CODE PROGRAM

Figure 15: Run time parameters group 
box.



19

UNDERSTANDING G-CODES

UNDERSTANDING G-CODES

G-Codes are the most common language elements for rectangular axis motion, 
especially for the fabrication industry.  They were invented when motion control 
electronics were very crude, and were therefore very simple.  Fortunately, while 
motion control electronics are now very complex, G-Codes are still blissfully 
simple and very easy to learn.  Basically, a single G-Code move is a single line 
of text.  The text is comprised of alternating letters and numbers.  The letter tells 
the control what to do and the number is sometimes part of the letter command 
and other times, the associated data.  The text “G0” (that’s a zero, not an o) 
means move straight and fast while “G1” means move straight and slowly.  “G2” 
and “G3” refer to clockwise and counterclockwise circular motion.  The codes 
X, Y, Z, W, A, and B are the ones that are followed by data.  Each one of these 
letters corresponds to an axis of motion.  Usually there are two or three axes 
in a system, X, Y or X, Y & Z.  The number following each letter represents the 
coordinate each axis needs to reach.  If two or more axes are mentioned on 
one line, then they will all move at the same time in such a way as to make a 
diagonal straight line.

For circular motion found in circles, arcs, and helices, two new parameters are 
needed to convey the radius value.  The end position is described with the X, Y, 
Z, W, A, and B coordinates just the same as with a linear move, but with circles 
and arcs, the relative distances from the beginning position to the arc center are 
described with the letters I, J, and K.  The actual radius of the arc is internally 
calculated based on this simple geometry.  For an arc in the X-Y plane, only I 
and J are used.  This is the default plane.

G-Codes are very efficient.  Once you say G1, X1.5 or J2, you need not do it 
again until you want a change.  If you have 10 moves, you will likely have 10 
lines of G-Codes.

G2 is for clockwise arcs and G3 is for counterclockwise arcs.  I, J, and K can be 
negative, and if no new X, Y, and Z coordinates are loaded, the end position will 
default to the start position and the motion will be a full circle.

M-Codes control non-motion features such as program flow, I/O and program 
termination.  For example, M30 turns off all I/O and ends a program.  M-Codes 
can be defined to turn On and Off the Digital Outputs in the motors.

Syntax Rules
- Single-line comments are allowed as long as you prefix the command with 

one of the following characters: / ‘ ; * (
- Tabs and spaces are ignored.
- Numbers are specified as integers or floating-point values in simple format. 
- All commands must be in capital letters.
- The number of G commands per line is at most 2.  If there are 2 G-Codes in 

a line the first one must be G17, G18, G19, G20, G21, G90, or G91.
- There can be zero or one M-Code, zero or one F-Command, and zero or 

one S-Command per line.
- M-Codes, S-Commands, and F-Command are processed (in the same 

order) before the G-Codes regardless of where they appear in the line.
- Line numbers are allowed only at the beginning of the line with letter N 

as their prefix.
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UNDERSTANDING G-CODES

Implemented G-Code Commands:
G00 Rapid Linear movement
G01 Feed Linear movement (at Normal Feedrate)
G02 Clockwise circular movement
G03 Counter-Clockwise circular movement
G04 Wait
G17 Select the X-Y plane for circular movements
G18 Select the X-Z plane for circular movements
G19 Select the Y-Z plane for circular movements
G20 Change units to Inch
G21 Change units to Millimeter
G90 Change coordinate system to absolute
G91 Change coordinate system to incremental
G92 Change the logical origin
F Change the Feedrate (Normal Feedrate)
S Change the Spindle Speed
P Change G04 wait period in milliseconds

The following table shows the reserved M-Codes. You cannot delete or change 
a reserved M-Code, nor can you add an M-Code with these values (e.g. add 
another M0).

M00 Pause
M02 End of program
M30 End of program and force turning off all of digital outputs.
M3 Turn on the Spindle clockwise
M4 Turn on the Spindle counterclockwise
M5 Turn off the Spindle

The following M-Codes are defined by default.  You may change them, or add/
remove M-Codes depending on your needs.

M8 Turn on the Coolant
M9 Turn off the Coolant
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UNDERSTANDING G-CODES

G0 Command

The “G0” command performs a rapid linear move using the Rapid Acceleration 
and Rapid Feedrate specified in the Movement page of the Setup property 
sheet.  The move always ends with a complete stop before the next move, 
regardless of the setting for transition speed.  This G-Code is typically used to 
position the axes to the starting point.

Example:
G0X1Y1     *Rapid move to 1,1
Z-0.25     *Rapid Z axis down

G1 Command

The “G1” command performs a linear move using the current normal accelera-
tion and feedrate.  Normal Acceleration and Normal Feedrate are defined in the 
Movement page of the Setup property sheet.  Normal Feedrate can be changed 
using the Feedrate scroll bar in the Panel View.  The settings for transition speed 
determine whether the motion stops between moves, slows down or just plows 
through to the next segment.

Example:
G1X1 *Move to 1,0,0 at default feed rate
Y1  *1,1,0
Z1       *1,1,1
X0Y0Z0    *0,0,0 Simultaneous 3 axis linear interpo-
lated  move 

G2/G3 Command

These commands perform circular movements using the current normal accel-
eration and feedrate.  Normal Acceleration and Normal Feedrate are defined 
in the Movement page of the Setup property sheet.  Normal Feedrate can be 
changed using the Feedrate scroll bar in the Panel View.  The settings for transi-
tion speed determine whether the motion stops between moves, slows down or 
just plows through to the next segment.

A circular or helical arc is specified using either G2 (clockwise arc) or G3 (coun-
terclockwise arc).  The axis of the circle or helix must be parallel to the X, Y, or 
Z-axis of the machine coordinate system.  The axis (or, equivalently, the plane 
perpendicular to the axis) is selected with G17 (Z-axis, XY-plane), G18 (Y-axis, 
XZ-plane), or G19 (X-axis, YZ-plane).  If the arc is circular, it lies in a plane 
parallel to the selected plane. 

If a line of code makes an arc and includes rotational axis motion, the rotational 
axes turn at a constant rate so that the rotational motion starts and finishes 
when the XYZ motion starts and finishes.

Ellipses are not currently supported.  If SMNC™ encounters a G2/G3 command 
that represents an ellipse, it will generate an error.
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Example:
G0X0Y0 * Go to 0,0
G2I1X1Y1  * clockwise quarter arc starting from 0,0
G18 * Set  XZ plane for circular movements
G1X0Y-2Z-1 * Go to position (0,-2,-1)
G2I0K1Y-1 * Draw a Helix with center of projected
  * circle at (0,0,0), Radius=1 and Height=1

G4 Command

The G4 command waits for a specified number of milliseconds.  G4 without 
parameters will simply force a stop at a vertex.  The number of milliseconds to 
wait is defined by the “P” Parameter.

Example:
G4P1000   *Wait for 1 second

G17/G18/G19 Command

These commands select the current plane for circular and helical movements.  
G17, G18 and G19 select the X-Y, X-Z and Y-Z planes respectively.  Any change 
in the value of a coordinate that is not in the current plane, will not be accepted 
and will generate an error.

Example:
G1X1Y0Z0 * Go to (1,0,0)
G17 * Select X-Y Plane
G2I-1J0K0 * Draw Circle Center (0,0,0) R=1 in X-Y Plane
G1X0Y0Z1 * Go to (0,0,1)
G18 * Select X-Z Plane
G2I0J0K-1 * Draw Circle Center (0,0,0) R=1 in X-Z Plane
G19 * Select Y-Z Plane
G2I0J0K-1  * Draw Circle Center (0,0,0) R=1 in Y-Z Plane

  

G20/G21 Commands

These commands set the current length units to Inch and Millimeter respec-
tively.  The default units are specified in the Movement Page of the Setup Prop-
erty Sheet.  The default of the default is Inches.  G20 and G21 codes can be 
mixed with the G0, G1, G2, and G3 codes within the same line.

Example:

G0X0
G21G1X10  *move 1cm along the X axis from 0,0

UNDERSTANDING G-CODES
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G90/G91 Commands

These commands set current coordinate system to Absolute and Incremental 

respectively.  The coordinate system is always Absolute When a program starts.  

G90 and G91 can be issued before the G0, G1, G2, and G3 codes on the same 

line. 

Example:

G1X1  * move to absolute (1,0)

G91G1X-1   * move back to absolute (0,0)

 

G92 Command

This command sets the logical origin for the rest of the G-Code program.  

Please note that to define the current position as the new logical origin, you 

must include all installed axes on the line. 

Example 1:

G1X1       * move to (1,0)

G92X0      * set (1,0) to (0,0)

G1X-1      * move back to (-1,0) logical or (0,0) 

absolute

Example 2:

G1X1Y-2Z3  * Move to (1,-2,3)

G92X0Y0  * set (1,-2,0) as new logical origin

G1X1Y1  * Move to (1,1,3) logical or (2,-1,3) 

absolute

 

F Command

This command changes current Normal Feedrate for subsequent non-G0 

moves. The “G20” and “G21” codes affect the units of the feedrate.  The time 

units are always minutes.  The current Normal Acceleration specified in the 

Movement page of the Setup property sheet is used to accelerate or decelerate 

to the speed specified by the “F” command.  The program always starts with the 

speed adjusted on the panel by the Feedrate scroll bar.  This code can be mixed 

with movement G-Codes and is processed before them.

Example:

G1X1F10    *move to 1,0 at a speed of 10 inch/min 

   (F command *is processed rst)

UNDERSTANDING G-CODES
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S Command

This command changes the current speed of spindle.  The number following the 
“S” letter indicates the new speed of spindle.  The value shows the percentage 
of maximum spindle speed as set in the Spindle page of the Setup property 
sheet and the sign of the number specifies the direction of rotation.  Negative 
numbers are used for clockwise rotations, and positive numbers are used for 
counterclockwise rotations.  For example, S-100 turns the spindle on with maxi-
mum speed in the clockwise direction.   An S0 command will turn the spindle off.  
You can mix M-Codes and S-Commands to control the Spindle.  M3, M4, and 
M5 are equivalent M-codes for S-100, S100, and S0.

Example:
G0X0Y0 * move to home
S50 * counterclockwise, %50 of max speed
G1X1 * go to (1,0)
M5  * turn off the spindle
Y2  * go to (1,2)
S-100 * clockwise, max speed

 

M0 Command

This command forces a pause for all motors.  When this command is reached, 
all motors decelerate to a stop using the current acceleration as defined in the 
Movement page of the Setup property sheet.  Its function is exactly the same 
as the Pause command in the menu or Panel View.  To continue running the 
program, the user must select the Run or Pause command from menu or click 
on the appropriate buttons on the Panel View. 

Example:
G1X0Y0   
M00    *Pause and wait for user command
G1X1

 

M2 Command

This command stops interpreting G-Codes.  It causes the motors to stop and 
sets the SmartMotor™ positions to the last known valid values.  It then resets 
all digital outputs and turns spindle and servo on/off depending on the settings 
in the General page of Setup property sheet.  If a command is after the “M2” 
command, or in the same line, it never gets executed and SMNC™ generates a 
warning when checking the G-Code program.  It is not necessary to include the 
“M2” command at the end of the program.

Example:
M2       *end program
G1X1      *this line never gets executed

UNDERSTANDING G-CODES
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M30 Command

This command stops the interpretation of G-Codes, and, unlike the “M2” com-
mand, turns off all digital outputs, regardless of the settings in the General page 
of Setup property sheet.  It stops the motors and sets the SmartMotor™ posi-
tions to the last known valid values.  The spindle and servos are turned on/off, 
depending on the settings in the General page of Setup property sheet.  Any 
command after the “M30” command, or on the same line, never gets executed 
and SMNC™ generates a warning when checking the G-Code program.  It is 
not necessary to include the “M30” command at the end of the program.

Example:
M30    *end program and turn off all digital outputs
G1X1   *this line never gets executed

M3 Command

This command turns the Spindle on clockwise.  If a SmartMotor™ is being used 
as a Spindle, it will accelerate to the maximum speed using the values specified 
in the Spindle page of the Setup property sheet for Spindle speed and accelera-
tion.  When using a SmartMotor™ as a spindle, the “M3” command is equivalent 
to the “S-100” command.  You can use the Axis page of Setup property sheet to 
define a SmartMotor™ to be in Spindle Mode.

If the Spindle is some other motor controlled by digital outputs originating from 
one of the linked SmartMotors™, the “M3” command turns on the related digital 
output as specified in the Spindle page of Setup property sheet.

Example:
G0X0Y0 * Go to origin
M3    * Turn on Spindle clockwise

M4 Command

This command turns the Spindle on counterclockwise.  If a SmartMotor™ is 
being used as the Spindle, it will accelerate to the maximum speed using the 
values specified in the Spindle page of the Setup property sheet for Spindle 
speed and acceleration.  When using a SmartMotor™ as a spindle, the “M4” 
command is equivalent to the “S100” command.  You can use the Axis page of 
Setup property sheet to define a SmartMotor™ to be in Spindle Mode.

If the Spindle is some other motor controlled by digital outputs originating from 
one of the linked SmartMotors™, the “M4” command turns on the related digital 
output as specified in the Spindle page of Setup property sheet.

Example:
G0X0Y0 * Go to origin
M4    * Turn on Spindle counterclockwise

UNDERSTANDING G-CODES
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M5 Command

This command turns off the Spindle.  If a SmartMotor™ is being used as the 
Spindle, it will decelerate to a stop using the acceleration value specified in the 
Spindle page of Setup property sheet.   When a SmartMotor™ is the spindle, the 
“M5” command does the same function as the “S0” command.  You can use the 
Axis page of Setup property sheet to define a SmartMotor™ to be in the Spindle 
Mode.

If the Spindle is some other motor controlled by digital outputs originating from 
one of the linked SmartMotors™, the “M5” command turns off the digital outputs 
for the “M3” and “M4” commands specified in the Spindle page of Setup property 
sheet.

Example:
G0X0Y0 * Go to origin
M4    * Turn on Spindle counterclockwise
M5    * Turn off Spindle

UNDERSTANDING G-CODES
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There are eight M-Codes 
defined by default in SMNC™.  
The user can Add, Edit, or 
Remove M-Codes in this page.  
A Maximum of 30 M-Codes 
are allowed in SMNC™.  Also, 
up to 6 buttons are available 
on the Panel View, which can 
be linked to the M-Codes.  By 
default, one of these buttons is 
related to Coolant (M8/M9).

Double-click on one of the 
M-Codes in the list to view 
the associated properties.  The 
M-Code properties dialog box 
will appear (Figure 17).

WORKING WITH M-CODES

WORKING WITH M-CODES

Click on the Setup button or select the Setup sub-item from the Tools menu.  
Select the M-Codes page in the Setup property sheet. (Figure 16)

Figure 16:  The M-Codes page of Setup property sheet.

Figure 17:  The M-Code properties dialog 
box.
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Each M-Code controls one or all of the digital outputs in one or all of the motors. 
For example, M8, as defined by default, turns on the output ‘C’ on the Smart-
Motor™ corresponding to the X-Axis.  For a two state On/Off command, you 
should define two different M-Codes.  You can assign a descriptive text to each 
M-Code.  If you want to reserve a button on the Panel View for the M-Code, 
you must enter the button number and some text to reside beside the button.  A 
value of 0 for button number means that you don’t want any button related to 
the M-Code.

Sometimes you may want to 
define an M-Code to do some 
specific action rather than 
just turn on or off an output.  
To define custom M-Codes, 
click on the Advanced button.  
The dialog box extends to 
show the advanced section 
(Figure 18).

You can now enter any SMI 
command in the SmartMo-
tor™ Command edit box.

Click on the cancel button 
to close the M-Code proper-
ties dialog box and the setup 
property sheet.  On the Panel 
View, and in the Digital Out-
puts group box, click on the 
button for Coolant on/off.  You 
will see that the color of 
the indicator on the button 
changes to Green, indicating 
that it is in the “On” state.  
Please note that all Smart-
Motor™ digital outputs are 
considered Active Low.  That means that in the “On” state, the output will go to 
0 VDC (from 5 VDC).

Click again on the button, and you will see the indicator becomes Black - indicat-
ing the “Off” state.

WORKING WITH M-CODES

Figure 18:  The M-Code properties dialog box - 
advanced.

SmartMotor™ 
commands can 
include motion 
commands for axes 
setup as 
“uncoordinated” or 
even “GOSUB” 
commands for 
SmartMotors™ with 
programs loaded in 
them.
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WORKING WITH M-CODES

Change the G-Code program and add some M-Code lines, as shown in the fol-
lowing code:

M8
G1X0Y.5Z0
G2I.5J0
M9
G1Z.5
G2I.5J0
G0Z0
X0Y0
M30

Click the Start button to run the program. Note that when the indicator in the 
source view reaches the M-Code lines, their related button on the Panel View 
changes color to indicate the new state on the digital output.
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IMPORTING DXF FILES

If you have AutoCAD® installed on your computer, start AutoCAD® and draw 
a number of simple objects such as lines, poly-lines, arcs and circles.  Please 
make sure that you are drawing in the range acceptable by SMNC™ as defined 
in the Axis page of Setup property sheet.

Then export the drawing to a DXF file, and select a name for your drawing.  
Finally, exit or minimize AutoCAD®.

Run SMNC™ and select the Import DXF file … sub-item from the File menu.  
The Import DXF File dialog box will appear. (Figure 19)

IMPORTING DXF FILES

Select the DXF file you created by AutoCAD® and click on the Open button.  You 
will see that SMNC™ creates an equivalent G-Code program for the DXF file.  
Run the created G-Code program and check the results.

Figure 19:  Import DXF file dialog box

The DXF 
conversion delivers 
center line motion.  
The Offset function 
within AutoCAD® 
may be useful in 
defining proper tool 
path.
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ERROR HANDLING

ERROR HANDLING:

SMNC™ comes with robust error handling capabilities.  Add some erroneous 
lines to the G-Code program as shown in the following code:

M8
G1X0Y.5Z0
G2I.5J0
M9
G1Z.5
G2I.5J0
G1X5  * Error
X0Y0Z0
G13  * Warning
G2I0.5J0.5X2  * Error
G0Z0
X0Y0
M30

Now click on the Start button to run the program. You will see that it detects two 
errors and one warning and shows them in the Errors View (Figure 20). 

Figure 20: The Errors and Warnings in the Errors View

You can always see the results of checking and running the programs in the 
status group box on the top left of Panel View (Figure 17).

Double click on one of the errors.  You will see that the line containing the error 
will be highlighted in the Source View, making it easy for you to edit the line 
to fix the error.  Now click one of the errors to select it, and press the F1 key.  
You will see the error message and the guidelines to fix the error appear in the 
help window.  You can also get help specific to an error using the context sensi-
tive help button on the toolbar (The button with an arrow and a question mark 
near it).  Click on the button and then click on the desired error line in the Errors 
View.

If there are one or more errors in the program, SMNC™ won’t run the program; 
but if there are only warnings, SMNC™ starts running the program after check-
ing the program and reporting the warnings in the Errors View.
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WRITING AND RUNNING A COORDINATED MOTION FILE

WRITING AND RUNNING A COORDINATED MOTION FILE

If the required contouring cannot be specified by simple G-Codes, it can be 

specified using the Coordinated Motion file format.

Select the New Coordinated Motion file sub-item from the File menu; and type 

the following data in the Source View.  Please note that the fields in each line 

are delimited by Tabs.

  0 0 0 0

  1000 1000 1000 1024

  2000 2000 2000 2048

  3000 3000 3000 3072

  4000 4000 4000 4096

  5000 5000 5000 5120

  6000 6000 6000 6144

  7000 7000 7000 7168

  8000 8000 8000 8192

  9000 9000 9000 9216

  10000 10000 10000 10240

You may create coordinated motion files in a spreadsheet and then save them 

as tab delimited text files.  The first three columns in this table are the coordi-

nates and the fourth column is the time for each coordinate.  The 11 points and 

their time values specify the path and speed of movement.  The point values 

are in SmartMotor™ Counts and the time values are in SmartMotor™ Sample 

Periods.   After typing the data, save the file using the Save As sub-item from 

File menu.  You will need to assign it a name.

Note that when you are working with a coordinated motion file, the buttons 

Pause and Step are disabled.  There is no pause or step mode when running 

coordinated motion files.  Furthermore, you cannot change the speed of move-

ment on the fly using the Feedrate scroll bar, because the speed of movement 

is specified by the data in the table and cannot be altered in real time.

Click the Start button and see the resulting movement.  Try again, studying 

the Run Time Parameters group box.  Note that Current Mode and Current 

Origin are not available for coordinated motion files, because they are G-Code-

specific parameters.

Each time you run the file, the device moves to the point (0,0,0) and then runs 

the file.  This movement to the start point in the table is called position initializa-

tion.  Different types of position initialization can be defined in the General page 

of the Setup property sheet.
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USING SMNC™ HELP

USING SMNC™ HELP

You can use the SMNC™ Help in different ways:

1. Context-Sensitive Help using F1: 

 Dialog and Message box:
 Just use the F1 key while the box is displayed.

 Errors View:
 Select the line and press the F1 key.  After pressing the F1 key, you will see 

the description of selected error.

 Menu command:
 Just press the F1 key when you are on the menu item that you want help on.

2. Context-Sensitive Help using the mouse:
 There is a context sensitive help button on the tool bar.  When you click on 

that (or press Shift+F1 on keyboard) the program enters the Help Mode and 
the cursor shape changes to the context sensitive help cursor, which is an 
arrow with a question mark near it.  In Help Mode you can use the mouse 
or keyboard to select a menu command, or an object on the Panel View or 
Toolbar, or even an error message in the Errors View.  Instead of executing 
the command, Help on that command or object is displayed.

 

3. Help Buttons: 
 You can also click on the Help button available on all dialog boxes to get help 

about that dialog box.

 

4. Table of Contents: 
 To see the list of topics of SMNC™ Help use the Contents command in the 

Help menu.

 

5. Index: 
 To see the index of SMNC™ Help, use the Index command in the Help 

menu.


